Notices

Copyright © 2013 Unico, Inc.

All Rights reserved. No part of this publication may be copied, reproduced, or reduced to any
electronic media or machine-readable format without the prior written permission of Unico, Inc.

The information contained in the manual is considered accurate to the best knowledge of the
supplier at the time of publication. The manufacturer assumes no liability for errors that may exist.
The supplier reserves the right to change data and specifications without notice.

All trade designations are provided without reference to the rights of their respective owners.

Printed in the United States of America
# Table of Contents

## 1 Introduction to UEdit® Software
  1.1 Overview .......................................................... 5
  1.2 Scope .................................................................. 5
  1.3 Intended Audience ........................................ 5
  1.4 Equipment Required ........................................ 5
  1.5 Optional Equipment ......................................... 5
  1.6 Installing UEdit® Software .............................. 5
  1.7 Starting UEdit® Software ................................. 6
  1.8 UEdit® Software Environment and Documentation ............................................. 6

## 2 Serial Connections
  2.1 100 MHz Control Module (DSP) ................... 7
  2.1.1 100 MHz (X10—PN 323-546, 323-547, 323-397) .......................................................... 7
  2.2 270 MHz Control Module (DSP) .......................... 9
  2.2.1 270 MHz (X27—PN 324-260) .......................... 9
  2.3 Compact 100 MHz Control Module (DSP) ........ 11
  2.3.1 Compact 100 MHz (X10—PN 325-656, 323-060) .......................................................... 11
  2.4 Compact 270 MHz Control Module (DSP) .......... 13
  2.4.1 Compact 270 MHz (X27—PN 325-231) .......... 13

## 3 UEdit® Communications
  3.1 Communication Connection ......................... 15
  3.2 Creating Connection Profiles ..................... 16
  3.3 Creating Serial Connection Profiles ............ 16
  3.4 Creating TCP/IP Connection Profiles ........ 18
  3.5 Connection Profiles ........................................ 20
  3.6 Device Identity Query .................................... 21

## 4 Keypad Emulator
  4.1 Go Online ...................................................... 22
  4.2 Changing the Display Size ......................... 23
  4.3 Display Units ................................................ 23
  4.4 Display Color ............................................... 24

## 5 Drive Diagnostic Display
  5.1 Drive Diagnostics Window ......................... 25

## 6 Device Archive
  6.1 Opening a Device Archive ......................... 26
  6.2 Outline View ............................................... 28
  6.2.1 Drive Details Section ............................ 28
  6.2.2 Data Tables Section ............................... 29
  6.2.3 Event Table Section ............................... 29
  6.2.4 All Events Log Section ......................... 30
  6.3 Menus View ............................................... 31
  6.4 Events View ................................................. 32
  6.4.1 Events Display Unfiltered ..................... 32
  6.4.2 Events Display Filtered ......................... 32
  6.4.3 Exporting Events to Text Format ........ 33
  6.5 Original View ............................................. 34
  6.6 Upload an Archive ...................................... 34
  6.6.1 Select Create a new Device Archive .... 35
  6.6.2 Specify the Drive’s Device Address ........ 35
  6.6.3 Specify the Appropriate Device Units .... 36
  6.6.4 Specify the Archive Content ................. 36
  6.6.5 Specify the Destination ....................... 37
  6.6.6 Upload the Archive .............................. 37
  6.7 Download an Archive ............................... 39
  6.7.1 Open an existing Device Archive .......... 40
  6.7.2 Select Archive Download ................. 40

UEdit® Software Quick Reference Guide 30 July 2013
LIT00175.003
# Table of Contents

6.7.3 Select the Device Address ...........................................................................................................41
6.7.4 Specify the Content to Download ..............................................................................................41
6.7.5 Step 3: Download the Archive .................................................................................................41

7 Compare Archives ............................................................................................................................43

8 UEdit® Projects ...............................................................................................................................44

8.1 UDT Files .......................................................................................................................................44
8.2 Open a UEdit Project .....................................................................................................................44
8.3 Start Monitoring .............................................................................................................................45
8.4 Entering and Viewing Data ...........................................................................................................46
8.5 Changing item values ......................................................................................................................47
8.6 Quick Start Menu ..........................................................................................................................47
8.7 Verifying Digital Signals ...............................................................................................................47
8.7.1 I/O List View ............................................................................................................................48
8.7.2 I/O Word View ..........................................................................................................................48
8.8 Stop Monitoring the Device ..........................................................................................................49

9 Download Software ........................................................................................................................50

9.1 Download Firmware .......................................................................................................................50
9.2 Advanced Download Firmware ....................................................................................................51
9.2.1 OS Revision At Least 400 But Less Than 440 ............................................................................51
9.2.2 OS Revision Greater Than or Equal to 440 ..............................................................................53
9.3 Download the UEdit® Project ......................................................................................................59
9.4 Default to Factory Values .............................................................................................................61
9.5 Set the Calendar and Time .............................................................................................................62
9.6 Store Defaults to Flash Memory ..................................................................................................64

10 Chart Recorder Tool .......................................................................................................................68

10.1 UCR Files ...................................................................................................................................68
10.2 Open a Chart Recorder File .........................................................................................................68
10.3 Chart Data Acquisition .................................................................................................................69
10.3.1 Recording Chart Data to Text File ..........................................................................................69

11 Data Sampler Tool ...........................................................................................................................71

11.1 UDM Files ...................................................................................................................................71
11.2 UDH Files ...................................................................................................................................71
11.3 Example: Downhole Sensor Data Sampler ....................................................................................71
11.4 Upload the Default Data Sampler Manager ..................................................................................71
11.5 Download the Data Sampler Manager .........................................................................................73
11.6 Enabling the Data Sampler .........................................................................................................74
11.6.1 Example: Data Sampler Error ..................................................................................................74
11.6.2 Example: Data Sampler Error ..................................................................................................74

12 Remote File Explorer Tool ..............................................................................................................75

12.1 Accessing Data Files ....................................................................................................................75
12.1.1 Safely Remove SD-RAM Data Disk .........................................................................................75
12.1.2 Safely Read Data from SD-RAM Data Disk ...........................................................................77
12.1.3 Formatting the SD RAM Data Disk ........................................................................................77
12.1.4 Open the Remote File Explorer Tool .......................................................................................78
12.1.5 Serially Read Data from the RD1 SD RAM Volume .................................................................79
12.2 Retrieving Data Sampler History Files .......................................................................................80
12.3 Viewing Data Sampler History Files ............................................................................................81
12.4 Data Sampler History Analyzer ..................................................................................................81

13 System Monitor Tool ......................................................................................................................84

13.1 USM Files ...................................................................................................................................84
13.2 Creating the System Monitor .......................................................................................................84
1 Introduction to UEdit® Software

1.1 Overview

UEdit® software is a suite of tools that runs on a PC using Windows 8, Windows 7, Windows Vista, Windows XP, or Windows 2000. These tools can be used to monitor, simulate, and provide diagnostic information from the drive in real time. They can also be used to configure and modify existing embedded drive programs.

UEdit Lite™ software has the tools, monitoring and viewing features of UEdit® software, but does not allow changing a UEdit® project or modifying a UEdit® device. UEdit Lite™ software can be used to as a diagnostic tool, and to enter setup data or monitor tasks and logic.

Being able to use UEdit® or UEdit Lite™ software to obtain archives, event histories, and charts is important to help troubleshoot and diagnose problems.

1.2 Scope

The purpose of this document is to provide a quick reference for the use of UEdit® tools for troubleshooting, diagnostics, and setup of your Unico drive. To configure or modify existing embedded programs refer to the UEdit® help menu and attend a training class.

1.3 Intended Audience

This document is intended for any person who may be installing, setting-up or monitoring Unico supplied drive using the UEdit® or UEdit Lite™ suite of software.

This document assumes:
- The reader is familiar with the operation of a PC.
- The reader is familiar with the operation of Unico supplied drive and application software.
- That either UEdit® or UEdit Lite™ software has been installed on the PC.
- That the appropriate device drivers have been installed on the PC.
- The reader has the appropriate communication devices to connect to your Unico drive.
- The reader has received some basic training on Unico products and software.

1.4 Equipment Required

- Personal Computer with UEdit® Software or UEdit Lite™ Software, Revision 401.
- Serial Cable.
  - RS-232 to RS-485 Unico Part #203069
  - USB to RS-485 Unico Part #714070. Requires Driver Software installed on the PC.

1.5 Optional Equipment

- To store Data Sampler History Files: Mass Data Storage Memory Module (SD-RAM) Expansion Module with SD RAM data disk (PN 323-863, 712-332, 930-468)

1.6 Installing UEdit® Software

From the UEdit® CD-ROM, choose the Install folder. Select ‘setup.exe’. Follow the Install Wizard instructions.
1.7 Starting UEdit® Software

Use the UEdit® shortcut on the PC desktop:

Or use the Start Menu:

1.8 UEdit® Software Environment and Documentation

From the Help pull-down menu choose Help Topics:
2  Serial Connections
   There are three serial ports on the DSP module. They are the named console, port A, and port B.

2.1  100 MHz Control Module (DSP)

2.1.1  100 MHz (X10—PN 323-546, 323-547, 323-397)
2.1.1.1 Console Port Serial Connection
Connect to the console port in only one of three connectors.
- J11: RS-232 Terminal
- J12: RS-485 Terminal
- Via TB1 terminals 1, 2, 3, and 4
Typically connection is made to J12 using either Unico cable 203069 or 714070.
On some systems a cable is run within the enclosure from J12 to an RJ45 connector on the enclosure door.
On some systems the console port is used to connect to a Modbus RTU radio or modem (land, cellular, satellite). Disconnect the radio or modem to use this port with the computer.

2.1.1.2 Port A Serial Connection
Port A can be connected via the J6 Terminal. On some systems port A is used to connect to other Modbus slave devices such as downhole or surface sensors.

2.1.1.3 Port B Serial Connection
Connect to Port B port in only one of two connectors.
- J3: RS-485 Terminal
- Bluetooth® Communication Module (PN 712-334, 713-335) may be inserted into CON7.
- MaxStream 900 MHz RF Wireless Module (PN 924-185) may be inserted into CON7.
- MaxStream 2.4 GHz RF Wireless Module (PN 924-186) may be inserted into CON7.
Pin-outs of all connectors can be found in the S1100 Installation, Maintenance, and Troubleshooting manual. The Unico part number for the current version of the manual is 110941 ECL 006.
2.2 270 MHz Control Module (DSP)

2.2.1 270 MHz (X27—PN 324-260)

2.2.1.1 Console Port Serial Connection

Connect to the console port in only one of three connectors.

- J4: RS-232 Terminal
- J6: RS-485 Terminal
- Via TB1 terminals 1, 2, 3, and 4

Typically connection is made to J6 using either Unico cable 203069 or 714070.
On some systems a cable is run within the enclosure from J6 to an RJ45 connector on the enclosure door.

On some systems the console port is used to connect to a Modbus RTU radio or modem (land, cellular, satellite). Disconnect the radio or modem to use this port with the computer.

2.2.1.2 Port A Serial Connection
Port A can be connected via the J3 Terminal. On some systems port A is used to connect to other Modbus slave devices such as downhole or surface sensors.

2.2.1.3 Port B Serial Connection
Connect to Port B port in only one of two connectors.

- J2: RS-485 Terminal
- Bluetooth® Communication Module (PN 712-334, 713-335) may be inserted into CON4.
- MaxStream 900 MHz RF Wireless Module (PN 924-185) may be inserted into CON4.
- MaxStream 2.4 GHz RF Wireless Module (PN 924-186) may be inserted into CON4.

Pin-outs of all connectors can be found in the S1100 Installation, Maintenance, and Troubleshooting manual. The Unico part number for the current version of the manual is 110941 ECL 006.
2.3 Compact 100 MHz Control Module (DSP)

2.3.1 Compact 100 MHz (X10—PN 325-656, 323-060)

2.3.1.1 Console Port Serial Connection

Connect to the console port in only one of three connectors.

- J1: RS-232 Terminal
- J3: RS-485 Terminal
- Via TB1 terminals 1, 2, 3, and 4

Typically connection is made to J1 using either Unico cable 203069 or 714070.
On some systems a cable is run within the enclosure from J12 to an RJ45 connector on the enclosure door.

On some systems the console port is used to connect to a Modbus RTU radio or modem (land, cellular, satellite). Disconnect the radio or modem to use this port with the computer.

2.3.1.2 Port A Serial Connection

On some systems port A is used to connect to other Modbus slave devices such as downhole or surface sensors.

Connect to the Port A port in only one of two connectors.

- J6: RS-485 Terminal
- Bluetooth® Communication Module (PN 712-334, 713-335) may be inserted into CON12.
- MaxStream 900 MHz RF Wireless Module (PN 924-185) may be inserted into CON12.
- MaxStream 2.4 GHz RF Wireless Module (PN 924-186) may be inserted into CON12.

Pin-outs of all connectors can be found in the S1100 Installation, Maintenance, and Troubleshooting manual. The Unico part number for the current version of the manual is 110941 ECL 006.
2.4 Compact 270 MHz Control Module (DSP)

2.4.1 Compact 270 MHz (X27—PN 325-231)

2.4.1.1 Console Port Serial Connection

Connect to the console port in only one of three connectors.

- CON19: RS-232 Terminal
• CON20: RS-485 Terminal
• Via TB1 terminals 1, 2, 3, and 4
Typically connection is made to CON20 using either Unico cable 203069 or 714070.
On some systems a cable is run within the enclosure from J12 to an RJ45 connector on the
enclosure door.
On some systems the console port is used to connect to a Modbus RTU radio or modem (land,
cellular, satellite). Disconnect the radio or modem to use this port with the computer.

2.4.1.2 Port A Serial Connection
On some systems port A is used to connect to other Modbus slave devices such as downhole or
surface sensors.
Connect to the Port A port in only one of two connectors.
• CON18: RS-485 Terminal
• Bluetooth® Communication Module (PN 712-334, 713-335) may be inserted into CON25.
• MaxStream 900 MHz RF Wireless Module (PN 924-185) may be inserted into CON25.
• MaxStream 2.4 GHz RF Wireless Module (PN 924-186) may be inserted into CON25.
Pin-outs of all connectors can be found in the S1100 Installation, Maintenance, and
Troubleshooting manual. The Unico part number for the current version of the manual is 110941
ECL 006.
3 UEdit® Communications

UEdit® software can communicate through any asynchronous serial port on the PC host (typically COM1 or COM2). It also supports modem and TCP/IP connections. Most devices are wired RS485 and can be used to multi-drop, but RS232 may be used for a single device connection.

The device that the software will be communicating with should be connected to the PC using a cable such as P.N. 203-069 or P.N. 714-070. The device connected will have several options that must be adjusted in order to complete the serial protocol connection.

3.1 Communication Connection

The connection can be opened and closed using the settings of a connection profile with the 'Connect' and 'Disconnect' options under the 'Communications' menu.

The user may also connect or disconnect using the 'Toggle Connection' toolbar button. This toolbar button displays when disconnected, and when connected.
3.2 Creating Connection Profiles
Use Manage Connection Profiles from the pull-down menu to create connection profile(s). Create a connection profile that matches the drive settings.

3.3 Creating Serial Connection Profiles
Choose New…

Choose Serial then Next
Specify the Serial Port, typically Communications Port (COM 1). Match the Serial settings with the drive Comm settings. Note: Data Rate is called Baud Rate in the Drive software. Choose Next.

Specify the Protocol and timeout settings. Choose Next

Specify the reconnect settings. Choose Next
Name the profile. Choose Finish.

3.4 Creating TCP/IP Connection Profiles

Choose New…

Choose TCP/IP then Next.
Enter the Host Address and Port.

Specify the Protocol and timeout settings. Choose Next

Specify the reconnect settings. Choose Next
Name the profile. Choose Finish.

3.5 Connection Profiles

Use Manage Connection Profiles from the pull-down menu to create connection profile(s). Create a connection profile that matches the drive settings.

Once there is at least one profile, when the 'Connect' option is selected, the following window appears prompting the user to specify which connection profile to use when connecting. Choose the connection profile that matches the drive settings. If you are not sure of the connection profile, click the "Manage Profiles” button to edit or add a connection.

Specify the desired connection profile with the dropdown. Once a profile is selected, its communication settings are displayed. Click the 'Manage Profiles…' button to show the Connection Profile Manager window for managing the connection profiles. Click the 'Connect' button to apply the selected connection profile's communication settings and attempt the connection.
If the connection, between UEdit and the PC hardware, is successful, the status bar displays the connection status. If not, “Disconnected” is displayed in the status bar located at the lower right of the UEdit screen.

3.6 Device Identity Query

Use either the “Device Identity Query” command under the “Tools” menu or the icon on the toolbar to initiate a communication check.

When the Start/Stop button displays the image, the query process is stopped. Pressing the button with this image will start the device identity query process.

When the Start/Stop button displays the image, the query process is running. Pressing the button with this image will stop the device identity query process.

If everything is working you should see the following with the blue background alternating blue to white.

If the background does not flash then you should check your cables, ports, protocols, baud rates, and device addresses.

Use the image to select other device addresses.
4 Keypad Emulator

The Keypad Emulator is a tool that emulates the physical UNICO drive display and keypad. The user can remotely communicate with a connected drive and traverse through the drive menus as if they were physically at the drive. The emulator supports both a 2-line by 24-column and a 16-line by 40-column graphic display. Display font and data units may be modified to the user's liking. Multiple Keypad Emulator windows may be open simultaneously and connected to the same or different drives on the same multi-dropped serial network.

To use the keypad emulator make sure you have a communication link between the drive and your PC. See section 3 for establishing and verifying communications.

Use the UEdit Help menu to review the setup and functioning of the keypad emulator.

To open the keypad emulator from the tools menu, select keypad emulator or select the icon.

4.1 Go Online

After the display is open to go online and communicate with a connected device, select the appropriate device address of a connected drive from the drop-down list in the toolbar and press the button on the toolbar or in the application menu. The standard (default) drive address is 1.
4.2 Changing the Display Size

To change the display size, choose the desired display size from the main application menu under the 'Keypad' menu option. The current size is designated with a check mark.

The Keypad Emulator window will automatically resize itself to accommodate the new display size.

4.3 Display Units

The user may change the units that data values are displayed with. The unit options may vary from drive to drive. To change the display units, with the keypad monitoring, choose the 'Units…' option from the main application menu under the 'Keypad' menu option.
Upon selecting 'Units...' from the menu, the following window will appear with available unit options.

![Device Units Window](image)

Select the desired units and click 'OK' to modify the current units to the new selection. The Keypad Emulator will now display values in the selected units.

### 4.4 Display Color

The user may change the Display to the color graphics mode. This selection must be made with the keypad not in monitor mode. To change to the color graphics mode, select the "Color" option from the main application menu under the 'Keypad' menu option.

![Color Menu Option](image)

Upon selecting "Color" from the menu, keypad will change and will display with a blue background and white lettering once monitoring resumes. Color enhances the chart displays.
5 Drive Diagnostic Display

The Drive Diagnostics is a tool that monitors drive-specified values that are essential to understand how the drive is currently operating.

To use the drive diagnostic display make sure you have a communication link between the drive and your PC. See section 3 for establishing and verifying communications.

Use the UEdit® Help menu to review the setup and functioning of the diagnostic display.

To open the diagnostic display from the tools menu select drive diagnostics or select the icon.

5.1 Drive Diagnostics Window
Device Archive

The **Device Archive** tool collects information from the drive and displays it in various ways. It also allows downloading information back into the drive. This tool will archive drive data and will now archive the event log which eliminates having to open the UEdit® Project to capture this log. Archives taken with previous editions of UEdit® software are supported and can be opened, viewed and downloaded.

### 6.1 Opening a Device Archive

To open an existing archive, select Device Archive from the tools menu or Click on the icon. An “Open a Device Archive” dialog box will open. Select “Open an existing Device Archive”, click on “Browse” and then click on OK. Recently opened archives will be displayed below the “Browse” selection.
Navigate to where the Device Archive you want to open is saved. The software is looking for either a text formatted document (.txt) or a archive formatted document (.arx). Click on the file and then on Open.

The archive will open with the Outline view selected. You can navigate to the sections of the Outline view or click on the Menu, Events or Original tab to view their contents.
6.2 Outline View

This view displays the individual sections of the archive in the left window pane and the contents of the selected section in the right. Displayed below are the recommended sections to select when uploading an archive. On more current revisions of software the arx format can capture the fault, warning, data change and event log at one time and display them chronologically at the same time where as the txt format can only capture each individual log and display them one log at a time. This feature is why the arx format is the recommended format to use when archiving.

The recommended sections of the ARX file format will be now be described in further detail.

6.2.1 Drive Details Section

Clicking on the Drive Details in the left pane will display all the information of the drive that was uploaded in the archive. The more current the version of the software in the drive, the more information gathered at the time of the archive. The software used for this example uploaded the UEdit® software number, the base application and the OS software number. It also captured the application type and base type along with the drive date and time of the archive.

More information will be available with future OS and application software releases.
6.2.2 Data Tables Section

This section displays the drive parameters as they are displayed in the global dictionary found in the drive’s help menu. From right-to-left the data is displayed using the following format: index number, parameter name, the parameter value at the time of archive, the units used and the unit index.

6.2.3 Event Table Section

This section displays the defined drive event masks. If the archive was taken using the arx file format the information captured will contain the event name, its Invert and force masks, whether the event is a fault, a warning, or an event, and what data will be captured when the event occurs. In the example shown below, the event bus voltage is not inverted nor is it forced on or off. It is currently set as a Fault. The parameters bus voltage, vsd voltage, motor torque, vsd current, and motor velocity will be latched at the time of a bus voltage fault and recorded in the event history.
If the archive was taken using the txt file format, the information captured will only detail if the event is enabled as a Fault, Warning or Event.

6.2.4 All Events Log Section

If the archive was taken using the arx file format one of the sections that can be captured is the All Events section. This section will display all faults and events that were currently stored in the drive at the time of the archive. They will be displayed chronologically based upon the drive date and time recorded at the time of the event.

If the archive was taken using the txt file format, the closest section available that captures event details would be the fault log. This captures only faults and warnings and does not capture events.
6.3 Menus View

With a Project file that contains the exact program version specified in the archive that is open, the menu view will display the Data Table in the format defined by the menu structure in the project. This allows the user to navigate the archived parameters as they are found in the menus of the drive.

If no project file is open or if the Project file does not contain the exact program version specified in the archive an error dialog box will pop up when you try to expand the dictionary in the view window.
6.4 **Events View**

6.4.1 **Events Display Unfiltered**

Clicking on the Events tab will display all the recorded fault, warnings, events, and system errors that were uploaded in the archive. An ARX formatted archive that has the All Events Log as part of its contents will provide the most complete picture of the drive for this view. The information will be initially displayed with the most recent event at the top. Clicking on the column header Name, Date, Time or Type will sort the events based on that header. Clicking on the column header again will toggle the list between Descending and Ascending order.

6.4.2 **Events Display Filtered**

To facilitate viewing, the Events tab offers a filter feature. In the lower left hand corner of the Archive window are buttons to activate individual filters. ![Faults], ![Warnings], ![Events], ![Data Change Events], and ![System Errors] can be filtered or unfiltered by clicking on their respective selection buttons. An inactive filter will have a box around the button and an active filter will not. Filters that have no events in the archive will be grayed out. In this example there are no system error events recorded.
6.4.3 Exporting Events to Text Format

The information displayed in the Events Tab can be exported as a text formatted file. Only information that has not been filtered out of the display will be exported. To begin the export function click on the export button found in the lower left hand corner of the archive window.

The Save As window will open. Navigate to where you want to save the file and change the file name if you so desire.

The above is an example of what an exported Event text file will look like.
6.5 Original View

Clicking on the Original view tab will display the raw archive file contents in the format it was acquired. The picture on the left is an example of the ARX file format and the picture on the right is an example of the TXT file format.

6.6 Upload an Archive

Before attempting to upload an archive make sure you have a communication link between the drive and your PC. See section 3 for establishing and verifying communications.

The upload process will go much faster if you stop all monitoring of the drive. It is recommended that you quit monitoring the project, the Keypad emulator, the data sampler manager, and stop running any charts. This step is not necessary but it will significantly shorten the time it will take to upload the archive.

To upload a new archive, select Device Archive from the tools menu or click on the icon.

---

It seems there is a link to a PDF page in the document. If you need to view the full page, please let me know.
6.6.1 Select Create a new Device Archive

An “Open a Device Archive” dialog box will open. Select “Create a new Device Archive” and then click on OK.

6.6.2 Specify the Drive’s Device Address

The upload wizard will then ask for you to specify the appropriate device.

Select the drives device address from the drop-down list. The typical device address is 1. Then choose Next.
6.6.3 Specify the Appropriate Device Units

Select the appropriate device units from the drop-down list. NOTE: Using (default) as the Device Units is not recommended. The drop-down list displays device-specific units that have been previously retrieved from the drive.

Once the appropriate units have been specified, click the 'Next' button to continue on to the next step.

6.6.4 Specify the Archive Content

First, select the format you want for the archive. It is recommended that the ARX format is used as it provides more data than the TXT format archive. The ARX format is best for historical recording and for troubleshooting. However, at this time, there is no export function for the data tables so the TXT format is best for creating a hard copy of parameters for use by individuals who do not have UEdit® software.

Next, select the contents you want to archive. It is recommended that the Data Tables, Event Table and All Events Log are selected. The Fault Log, Event Log and Data Change Log are captured when the All Events Log is selected. After you have checked the contents you want to archive, click on Next.
6.6.5 Specify the Destination

A destination must be specified for the output of the archive. This is the location where the file will be stored on the PC. To change the file name or to change the location where the file will be saved, click the 'Browse…' button and a Save File As window will open up. The selected file path is displayed above the 'Browse…' button. If the specified file does not exist, it will be created when the upload begins.

Add Time Stamp

The user may desire that the output file be named with the date and time the archive is created. Check the 'Add Time Stamp' box to enable this feature. If this box is checked, the pseudo-filename is displayed with 'YYYYMMDD HHMMSS'. The 'YYYYMMDD HHMMSS' portion of the file name represents the date/time format where:
- YYYY = 4-digit year
- MM = 2-digit month
- DD = 2 digit-day
- HH = 2-digit hour
- MM = 2-digit minute
- SS = 2-digit second

Once the destination file is specified, click the 'Next' button to continue on to the next step of the process.

6.6.6 Upload the Archive

A brief summary is now shown. If the settings are incorrect, click the 'Back' button to re-enter them, otherwise select the Upload button.

Click the 'Upload' button to start the upload process. The progress (percent complete) of the upload process is displayed until it has successfully finished, failed, or been canceled by the user.
Once the upload has begun and the archive file name contains the date/time format 'YYYYMMDD HHMMSS', the time format will be replaced with the actual date/time. A progression bar will show how far along the upload is.

After the Device Data values are uploaded the wizard will begin to upload the next content selection. In this example the Event Mask upload is 63% complete.

When uploading the All Events log, the size can vary depending upon how many events have occurred. The wizard will state that the file size is unknown and will display the number of bytes uploaded instead of a percentage of completion.
When the Archive has successfully completed, the wizard will automatically open the archive in the work area of the UEdit® software screen.

6.7 Download an Archive

Before attempting to download an archive make sure you have a communication link between the drive and your PC. See section 3 for establishing and verifying communications.

Unlike previous versions of UEdit® software, you will need to first open the archive you wish to download.

To open an existing archive, select Device Archive from the tools menu or click on the icon.
6.7.1  Open an existing Device Archive

Once the “Open a Device Archive” dialog box opens, select “Open an existing Device Archive”, click Browse and then click on OK.

Navigate to the archive you want to download, click on the archive name to select the file and then click on Open.

6.7.2  Select Archive Download

Once an archive is open, the command line will display an Archive selection. Click on Archive and then click on Download from the drop down options.
6.7.3 Select the Device Address

6.7.4 Specify the Content to Download
Select the content you wish to download. Content which is not available to download will be grayed out and content that is available will have an open check box. Click on the check box that is beside the content you wish to download; normally this would be the Data Tables. After content has been selected, identified by a check in the check box, click on Next.

6.7.5 Step 3: Download the Archive
A brief summary is now shown. If the settings are incorrect, click the 'Back' button to re-enter them, otherwise select Download.
Click the 'Download' button to start the download process. The progress (percent complete) of the download process is displayed until it has successfully finished, failed, or been canceled by the user.

The 'Open the error log and close this window when the download completes' box is selected by default. This is the recommended setting.

Upon completion of the download, the drive will be rebooted for the new values to be loaded. The error log will open and display the status of the download.

Turn off power to the drive. Wait until all power is lost.
Turn on power to the drive.
Repeat the instructions in sections 6.7.2 through 6.7.5.
7 Compare Archives

The data archive compare tool allows the user to visually compare differences between two TXT formatted data archive files. Currently, ARX formatted data archives cannot be compared. The implementation of this feature with ARX formatted files is planned for future release. Differences in data archives may give the user insight to problems occurring with a particular device. These archive files are typically generated with the 'Upload Device Archive' feature.

Communication with the drive is not necessary to compare archives.

To open the compare archive window from the tools menu select Compare Archive Files.
8 UEdit® Projects

A UEdit project contains all the network devices that are on the network. Typically a project contains a single device. Each device contains information about the device such as a data layout of all the dictionary points within a drive, an I/O layout of each I/O point the drive has available, and all of the faults, warnings, and events. It also contains tasks that are created by the programmer.

8.1 UDT Files

Project files are stored with the '.udt' extension.

UEdit projects can be monitored but can't be created or modified using UEdit Lite™.

8.2 Open a UEdit Project

Open a UEdit project by double clicking on the .udt file on your PC or by using the File open command and selecting Project, or by selecting from a list of recent files that have been opened by UEdit.

1.1. The Project Window

The file name will be shown in window title. The project window can be found on the left-hand side of the UEdit window as shown below. The command line will now include the word Project.

A project opened with UEdit Lite will have the words PROTECTED in the window name. This is a clue that the project file may not be modified.
Commands that can not be used from Project menu will be gray.

Commands that can be used will be in black.
You should not need to use the Project menu. A description of the Project commands can be found in the Help file.

8.3 Start Monitoring

Before monitoring a device, make sure there is a communication link between the drive and the PC. See section 3 for establishing and verifying communications.

From the command toolbar select the Run Simulator / Monitor button to start monitoring.
A Simulate/Monitor Devices pop up screen will appear. Verify that the Address matches the Device Address set in the drive’s Comm menu.

![Simulate/Monitor Devices pop up screen]

To Change the Address, click on the current Address number. This will cause a drop down selection box to appear allowing you to select the appropriate device address.

![Modify Address dropdown]

8.4 Entering and Viewing Data

From the project window you can view the drive’s dictionary menu by double-clicking on Menus.

![Dictionary menu]

If the device is not being monitored the Value column will be empty and the Item column will contain all of the items in the menu.

Click on the Run button ▶️ to start monitoring or to change parameters.
8.5 Changing item values

If the device is being monitored the Value column will show the values in the drive and the status bar will be green.

Items that can be changed by the user will display a pencil icon to the right of the value. Items that are only for display will not.

To change an item, click on the item name and then push the enter key on your PC. You can also click on the item value. An item that is ready to be changed will be highlighted.

After being highlighted use the number keys on the PC keyboard to change numeric values. Enumerated values will have a drop dialog box that you can use to select the new setting.

Hitting the Esc key on the computer keypad will exit the parameter change mode without changing the value of the parameter.

8.6 Quick Start Menu

Click on the Quick Start menu to initially setup a drive or to view the drive setup.

You should be able to setup most wells from the Quick Start menu.

8.7 Verifying Digital Signals

In the Project window, double clicking on the I/O icon of a device, or by right clicking and selecting the 'Display' option opens the I/O window. The I/O window displays all the inputs and outputs located in the device. The I/O window has three views that display the I/O differently: List, Words, and Masks.
8.7.1 I/O List View

The I/O list view displays all the I/O by address showing the name and default name. Each address consists of the bit type, IN (input) or OUT (output), and the bit number separated by a colon. Inputs are displayed with a green bit icon, while outputs are displayed with a red bit icon. Left clicking a column header sorts that column of the view. The arrow image in the header displays whether the column is sorted in ascending or descending order.

When monitoring the lights are illuminated when the state is TRUE.

8.7.2 I/O Word View

The I/O word view displays the inputs and outputs in a graphical representation of an I/O word (16 bits).
Hover the mouse over the I/O bit to display its name.

8.8 Stop Monitoring the Device

When you have completed entering and viewing data or verifying digital signals it is best to quit monitoring the project. Click on the Stop button to quit monitoring.
9  Download Software

In the UEdit® Suite of Tools there are two methods which can be used to download firmware for either a new start-up or for an upgrade when not using the Upgrade Wizard Tool which, if available, is the preferred method. Both methods are found in the Tools pull-down menu. The first is the historical "Download Firmware" jumper method and the second is "Advanced Download Firmware" which does not require the use of the jumper.

9.1 Download Firmware

This tool can be used for all firmware, regardless of the firmware’s revision or the operating system revision being used. It does require physical access to the DSP module to install a boot jumper before downloading.

This method must be used if any of the following applies:

- The DSP is NEW and has never had anything installed in memory.
- If the current software OS Revision is less than 400. Verify using the Identity Query function. See section 3.6 for instructions.
- If the DSP has had its memory cleared. This is an unrecoverable state.
- Communication problems or noise occurred during a firmware download. This is usually caused when there are multiple serial connections to the port.
- The DSP powers up with a “HDW SFW Mismatch” message.
- If you are unable to establish any communications with the DSP.

If this occurs, then by definition the Console (sometimes called the Download) Port MUST be used. The enclosure door must be opened to check if the console port is already in use by another device. If there is anything connected in any ONE of the Console Port connectors (RJ connectors located on the lower left of the DSP or TB1 pins 1-4) then the external device’s connection must be temporarily removed. Typically this will be a serial sensor, modem or radio that must be installed in the RS232 RJ connector or TB1 pins 1-4.

The Boot jumper and ODL file will be used.
To launch the Download Firmware wizard, select Download Firmware from the Tools drop down menu.

The Download Firmware Wizard instructions will step you through the rest of the process.

9.2 Advanced Download Firmware

This tool was created to provide a way to update firmware that would not require the need to gain physical access to the DSP. Its implementation requires that there is already firmware installed which utilizes operating system software (OS) that provides this feature. The OS revision must be at rev 400 or above.

Determine what OS is installed in the drive by establishing communication and then launch the Identity Query tool (see section 3.6).

9.2.1 OS Revision At Least 400 But Less Than 440.

If the OS revision is at least 400 but less than 440, the Console (sometimes called the Download) Port MUST be used. This method will also work if the OS is 440 or greater but it does require you to gain access to the DSP module.

- The enclosure door must be opened to check if the console port is already in use by another device. If there is anything connected in any ONE of the Console Port connectors (RJ connectors located on the lower left of the DSP or TB1 pins 1-4) then the external device’s connection must be temporarily removed. Typically this will be a serial sensor, modem or radio that must be installed in the RS232 RJ connector or TB1 pins 1-4.
- The communication protocol for the consol port must be set to either ESP or Modbus RTU.
- The UEdit communication settings and the drive’s consol port settings must match.
- The Boot Jumper is NOT used.
Use the Tools pull-down menu.

Select the Device number.

Choose highest value. It will automatically select the best rate available.
Browse for the bin file.

Choose download.

9.2.2 **OS Revision Greater Than or Equal to 440.**

If the OS revision is 440 or greater, any port can be used to download the firmware. One of the following two methods will be used depending on if the Serial Color Graphics Keypad is being used. **NOTE:** Method 1 will take significantly longer to complete the download as the download speed is limited to the communication baud rate being used.

9.2.2.1 **Method #1:** Connect via the AUXILLIARY PORT on the Serial Color Graphic Keypad connected to the port on the door of the enclosure.

For factory built devices, this will be the hardware wiring design for all x10, x10 slim and x27 DSPs with Serial Color Graphic Display/Keypads.

- The DSP POWERED PORT on the Serial Color Graphic Display is plugged into Port A.
- The AUXILLIARY PORT on the Serial Color Graphic Display is connected to the port on the exterior of the enclosure.
- Computer is connected to the port on the exterior of the enclosure.
Verify using the Identity Query. Establish successful communications.
   a. Protocol MUST be ESP.
   b. Note the connection Baud rate.
   c. Note the Address (Device Number)

Use the Tools pull-down menu.

Select the Device number.
When using the AUXILIARY PORT you **MUST** match the current setups noted in step 1 above. Typically it will be 57,600 BAUD. It will be the EXACT same baud rate at which the connection used when doing the Identity Query above. Because this method must use the same baud rate as the keypad, it will take MUCH longer than the other methods. The advantage is there is no need to gain physical access to the DSP.

Browse for the bin file.

Choose download.
Error recovery: If the wrong baud Rate was chosen the display will show “Disconnected”.

Cycle power. Display will show a message such as this Cons:ESP:57600 Dev 1. Choose Restart then select the correct baud rate.
9.2.2.2 Method #2: Connect via any port on the DSP from the port on the door of the enclosure.

In this example, the port on the door of the enclosure is plugged into Port A. The computer cable is plugged into the port on the door.

Verify communication connections with the Identity Query.

Use the Tools pull-down menu.

Select the Device number.
Choose highest value. It will automatically select the best rate available.

Browse for the bin file.

Choose download.
9.3 Download the UEdit® Project

This task is done very rarely and only for very specific reasons. Only perform this download task when directed to do so by Unico personnel.

Open the UEdit Project for the appropriate application.

Choose Project: Full Download.
The wizard will then prompt to select the desired device address. To change the device address click on the address displayed and a drop down menu will appear.

Select the appropriate address and then click on OK.
Click on yes when asked to Switch to Program Mode

The project will then be downloaded to the drive

Click Yes when asked to Switch to Run Mode

Then click OK on the Download Complete pop up window.

Once the firmware and the UEdit project has been downloaded, default to Factory Values.
9.4 Default to Factory Values

After loading or updating software (unless the software update wizard was used), the software should be forced to load factory defaults to insure there is not corrupted data in the memory. To load the default factory values, go to the Setup Menu and select Archive (#6) then select Default (#3).
Choose Enter to Default.

Choose Enter to Reboot.

9.5 Set the Calendar and Time

After loading the default factory values, the calendar and the drive clock should be checked and updated. These are latched whenever a fault or event is logged and if they are incorrect, they can cause misinterpretation of this data. To check the calendar and clock settings go to the Setup Menu and select Help (#7).
Select Calendar (#6)

The date and time will be displayed. If any of this information is wrong, hit enter to edit.
The date will be the first field selected to be modified. The display will toggle between normal and reverse video on the item that is selected to be changed. To modify the field, use the up and down arrow, (use the function key to select the up arrow). The down arrow will advance the field by one and the up arrow will reduce the field by one. Hit the enter key to move to the next field when the current field is correct. Hitting enter will advance the field in the order of Date, Month, Year, Hour, Minute, and then Seconds. Hit quit when all fields are current.

9.6 Store Defaults to Flash Memory

After loading the default factory values and insure the calendar and the drive clock are correct, the values should be stored to flash memory for recall when a non-volatile memory loss occurs. This will insures that erroneous data that could potentially damage the drive or the equipment the drive is connected to will not be loaded.

**NOTE:** This step should also be done once a valid set of working parameters have been determined via a successful startup so that the drive will recover to an operable state if it ever experiences a non-volatile memory loss.

Go to the Setup Menu and select Archive (#5).
Select Store (#5)

The screen will display the last time values were stored as Defaults. Hit the enter key to continue.
Select 0 for no when asked to store as Default Data

Select 1 for yes when asked to save as NVmem defaults.
The drive will display that it is storing the values to flash memory and then it will reboot the drive. This will cause communication between the UEdit® Software and the drive to be lost.
10 Chart Recorder Tool

The UEdit® Software has a chart recorder tool that allows the user to sample data from a device and display it in a several graphical formats, Y(t), X-Y, and Polar. The chart recorder configuration and recorded data, if any, can be saved to file (*.ucr) using the 'File | Save' command.

10.1 UCR Files

Chart Recorder files are stored with the '.ucr' extension.

Chart recorder file contain both the definition of what is being sampled and the data sampled. These files with the raw data and chart of the can be saved for later viewing or sent by email for viewing by others.

10.2 Open a Chart Recorder File

To use the chart recorder tool make sure you have a communication link between the drive and the PC. See Section 3 for establishing and verifying communications.

Use the UEdit Help menu to review the setup and functioning of the chart recorder tool.

Open a chart recorder window by double clicking on the .ucr file on your PC or by using the File open command and selecting Chart Recorder, or by selecting from a list of recent files that have been opened by UEdit.
10.3 Chart Data Acquisition

To start the chart data acquisition, select the button on the chart recorder toolbar.

Once the data collection has begun, the collection can be halted/stopped using the button.

10.3.1 Recording Chart Data to Text File

To record the chart data to a file, select the Record to File toolbar button. When the button is clicked, a dialog will prompt for a file to save the recorded data stream to.

Once the file is setup, the chart recorder will save the data to the file until data acquisition is stopped. The record to file button will remain depressed and display the Stop Recording image until the button is pressed again or the data acquisition is stopped.
The file path and the number of data samples recorded to the file are displayed in the status at the bottom of the chart recorder window. The recording status will flash and is displayed with the recording image.

The data is date and time stamped and this information is displayed in the status area.

If data was not being recorded while it was being collected but needs to be saved, once the data collection is stopped, save the (*.ucr) file by choosing the File pull-down menu then select Save As.
11 Data Sampler Tool

The UEdit® Software has a data sampler tool that allows the user to sample data from a device and display it in several graphical formats, Y(t), X-Y, and Polar. The data sampler configuration is saved to a data Sampler Manager file (*.udm).

The recorded data can be saved to a Data Sampler History file (*.udh).

11.1 UDM Files

Data Sampler Manager files are stored with the '.udm' extension.

Data Sampler Manager files define one or more samplers, the data to be sampled, sample frequency, sampling triggers and the formatting of the display of the sampled data.

11.2 UDH Files

Data Sampler History files are stored with the '.udh' extension.

Data Sampler History files contain the sampled data.

11.3 Example: Downhole Sensor Data Sampler

The data sampler is used to sample signals in the Unico drive in real time. The data can then be stored to a file on a mass storage device, or recorded during viewing of the sampler on the PC. Multiple sampler buffers can be configured to run on a single data sampler that can be setup to trigger from conditions.

To use the data sampler tool make sure there is a communication link between the drive and the PC. See section 3 for establishing and verifying communications.

Use the UEdit Help menu to review the setup and functioning of the data sampler tool.

11.4 Upload the Default Data Sampler Manager

Create a new data sampler manager file by selecting the data sampler tool from the UEdit toolbar or from the File New menu.
Select Create a new Data Sampler Manager in the dialog box then click on OK.

Select Reset the device to factory defaults, then retrieve the manager, select the correct device number in the Device field and then click on Next.

After uploading the data sampler from the device the following window will open. Click Finish.

Each drive application will have a different default Data Sampler Manager suitable for that application.
11.5 Download the Data Sampler Manager

- Choose the Data Sampler pull-down menu, and then Download.
- Typically Choose Yes to remove history files.

- Choose Yes to enable the data samplers.

- The Data Sampler Manager is downloading.

- Choose OK to complete the download.
11.6 Enabling the Data Sampler

The list of the samplers is shown in the manager pane, and each one can be enabled or disabled by selecting the button directly to the left of the data sampler name. The button will display green when the sampler is enabled.

Data samplers can be enabled or disabled when connected to a device, and monitoring has been selected. To start the monitoring, select the 'Go' button on the data sampler toolbar. The button will toggle to 'Stop' to indicate that monitoring is on-line. To stop monitoring, press the 'Stop' button.

11.6.1 Example: Data Sampler Error

Buffer size is too large or there are too many signals being sampled. Reduce buffer size or eliminate unused signals.

11.6.2 Example: Data Sampler Error
12 Remote File Explorer Tool

The Remote File Explorer is a tool to browse for files located on one or more volumes (disks) installed on a device. You can perform basic file and directory tasks, such as creating, deleting, copying files and directories, and more advanced tasks, such as changing file and directory names.

To use the remote data explorer tool make sure you have a communication link between the drive and your PC. See section 3 for establishing and verifying communications.

12.1 Accessing Data Files

This tool is used to retrieve files written to the RAM volume on the DSP or the Mass Data Storage Memory Module (SD-RAM) Expansion Module with SD RAM data disk (PN 323-863, 712-332, 930-468).

There are two ways to retrieve the stored data:

1. Remove the Data Disk and retrieve the files with a SD RAM Card Reader.
2. Retrieve the files serially using the Remote File Explorer Tool.

12.1.1 Safely Remove SD-RAM Data Disk

If supported by the application, the Project’s Dictionary Menus will include a GMC® File Menu.

If this menu exists, there is a provision to ‘Safely Stop’ activity to the SD-SAM data disk to avoid collisions that may cause file corruption and data loss. Use file disk manager to prepare the disk for removing.

Choose SAFELY REMOVE to prepare to safely remove the SD-RAM data disk from the Mass Data Storage Module. Wait until file disk state is SAFE TO REMOVE before removing the data disk. This process may take several minutes.
As long as file disk state remains SAFE TO REMOVE, all data collection and storage services are suspended. If the Memory Expansion Module has the hardware Manual Mount/Unmount Switch, press the switch and then remove the data disk and using a card reader, copy the desired contents to your computer.

Return the data disk to the Module and choose RESUME OPERATION to resume data collection and storage services.
12.1.2 Safely Read Data from SD-RAM Data Disk

If supported by the application, the Project's Dictionary Menus will include a File Menu.

If this menu exists, there is a provision to 'Safely Pause' activity to the SD-SAM data disk to avoid collisions that may cause file corruption and data loss. Use file disk manager to prepare the disk for Reading.

Choose SAFELY READ.

Wait until file disk state is SAFE TO READ before using the Remote File Explorer Tool to access data on the data disk. This process may take several minutes.

When access is complete, choose RESUME OPERATION to resume data collection and storage services.

12.1.3 Formatting the SD RAM Data Disk

The Memory Expansion Module can only use Standard Size, Standard Capacity SD Ram data disks. This limits the card size to 2 GB of data. Before purchasing a SD card to use with this device, make sure that the card does NOT have the HC or XC designation on it. These cards are of a newer format and cannot be used with the Memory Expansion Module. The Unico part number for the appropriate 2GB SD card is 930-468.
The SD RAM Data disks must be formatted with your computer’s internal or external card reader. You must specify the FAT file system. Make sure to add a name to the Volume Label as the disk **MUST** have a name to be visible to the Remote File Explorer. The volume label is limited to 8 characters.

**12.1.4 Open the Remote File Explorer Tool**

Use the Tools pull-down menu. Choose Remote File Explorer.

Or select the icon.

Right click on the device and select the appropriate device number. The device number is the serial address for the port in use.
Expand the device to view the available volumes. This list will vary. The list is dependant upon several factors, Drive Series, Software application, OS, presence of the Mass Data Storage Module, etc.

1. **nvhd**: Non-volatile memory on the DSP. This area may be used to store Data Sampler History files if there is sufficient space.

2. **nvrds**: Non-volatile retained memory on the DSP. Files in this volume are stored in flash memory.


4. **rd1**: Removable Disk 1. The RD1 Volume is the SD RAM Data Disk. The volume name defined when formatting the data disk is in parentheses. Some application will use this volume to store files containing sampled data. These files will have the extension 'brd' for binary report data. Off-line tools must be created and used to un-package the data included in the file to a readable format. Contact Unico for the BRD File Format definition. The *.mfi and/or *.udi files are used for file serialization and should not be erased.


6. **UEdit**: Files used by the firmware.

### 12.1.5 Serially Read Data from the RD1 SD RAM Volume

Ensure that the data disk is in the Mass Data Storage Module and *file disk state* is SAFE TO READ. Expand rd1 to view folder contents.

Browse the file structure to find the desired file. Right click on the file name then choose copy. This action will copy the file to your computer’s hard drive.
12.2 Retrieving Data Sampler History Files

Data Sampler History files are stored to the DSampler folder in the RD1 volume. To retrieve Data Sampler History (*.udh) files use remote data explorer tool. Follow the methods described above in this section.
12.3 Viewing Data Sampler History Files

To view the Data Sampler History file, in UEdit choose File: Open: Data Sampler History.

12.4 Data Sampler History Analyzer

To view multiple Data Sampler History files in one window, Select Data Sampler History Analyzer from the Tools drop down menu or click on the Icon.
Navigate the open dialog box to the file where the data sampler history files reside and click on the first file you are interested in.

Then either hold down the Shift key on your keyboard and click on the last file in the series you want to look at or hold down the Ctrl key and click on the individual files you want to analyze.

The example below shows 16 data sampler history files. Each file consists of up to 24 acquisitions. The chart displayed is the third acquisition of the second file.
Hovering the cursor over an individual acquisition will display information regarding the acquisition. Hovering the cursor over an individual file will display information regarding that file.
13 System Monitor Tool

UEdit has a system monitor tool that allows the user to sample data from all of the devices in a field. The system monitor configuration is saved to a data System Monitor file (*.usm).

The system monitor polls each device in a round-robin fashion and displays.

13.1 USM Files

System monitor files are stored with the '.usm' extension.

13.2 Creating the System Monitor

Use UEdit Help to assist in defining and implementing a system monitor.

Sample system monitor